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Overview

This article will teach you how to export your records as households by combing people who share the same home address.

« Tip: You can still run this utility if you haven’t householded your database, but for the best results it’s worthwhile to take the time to fully
household your database. If your database is really large, or the data is not consistent this project will likely take some time. If you have already

householded your database, you can run this process directly from the Households list which allows for more flexibility on what columns to
export. Here’s an example (covered in-depth in its own section further down in this article):
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ol Settings  Help
Application Menu «]| 3 Search R Reset | 4k New oS File ~ Edit - | ) | Household List

E=® "

Tasks

| Favorites | Name | Count [ Contact (Any) [ Contact (1) | Contact 2 | QL |

]
> [ Dashboard o If you've already householded your database
[ Organization
£ o | h from the 'Households' li
b vge Calendar/Tasks Name you can run these exports from the Households' list
» B Canvassng & R .
4 B Contact Seluttion Name: which will have less columns than if you export from
[BE contacts Envelope Name: = - =
& Adaresses e ra—— the Donor/Voters list, and you can included just the
¥ Ad) .
@ Households <— - -
B Contact Relationships columns that you want via formatting.
. @y Contributions/Pledges /
1+ £ Product Sales Y
I 2> Logs
- [ L= & . .
> g:iomm_ul:lcahons S8 Edit | Sort [ Format ~ 53 Wrap & Print | ) Pivot |
E %S;:e":"a“a Household List [ 10874 records found | _ _
HH Expoticontentsoflisty) ContactID  Last Name First Name Contactip  Last First MI
4 Household Name GUsenald salutation Name Household Envelope Name MI (1) Name Name
= ) W) ) @ @ @ @
Admin Admin Admin 1
6369 Aagard, Martha R Martha Martha Aagard 2 R
6370 Aakhus, Ariel Marie Ariel Ariel Aakhus 3 Aakhus riel Marie
6371 Aakhus, Cindy Lee & Steven Eric Steve and Cindy Steve and Cindy Aakhus 4 Aakhus Cindy Lee 5 Aakhus Steven Eric
6372 Aamaot. Barbara A Barbara Barbara Aamot [ Aamaot Barbara A
anenson, Pamela Marie amela amela Aanenson 7 anenson amela arie
6373 A P; la Mari Pi | P; la A 7 A P 1 Mari
6374 Aanonson, Leland Eugene Leland Leland Aanonson 8 Asnonson Leland Eugene
6376 Abdi, Ali Hassan Ali Ali Abdi 11 Abdi Ali Hassan
8377 Abdi, Halimo Mohamed Halimo Halimo Abdi 12 Abdi Halimo Mohamed
i. Nimo Mohame: imo imo i 13 i imo ohame
6378 Abdi, Mimo Moh d Ni Mimo Abdi 13 Abdi i) Koh: d
6379 Abdulali, Quaid Quaid Quaid Abdulali 14 Abdulali DQuaid
6380 Abdurahman, Avan Adan Ayan Ayan Abdurahman 15 Abdurahman Ayan Adan
Open Windows 68381 Abel, Tasha Margaret Tasha Tasha Abel 1B Abel Tasha Margaret
D % D] B d 6382 Abouaish, Yasmine ¥ Yasmine Yasmine Abouaish 17 Abouaish Yasmine ¥
Start Page 6383 Abraham. Timothy Richard Timothy Timothy Abraham 13 Abraham Timothy Richard
@ Household List 6334 Abrahamian, David David David & Ann Abrahamian 20 Abrahamian David
6385 Abrahamson, Roger Mark Roger Roger Abrahamson 22 Abrahamson | Roger Mark
6386 Abukar, Halima Haji Halima Halima Abukar 23 Abukar Halima Haiji
6387 Acaso, Kathleen Krantz & Jonathan Kathleen and Jonathan Kathleen and Jonathan Acaso 25 Acaso Kathleen Krantz 24 Acaso Jonathan
6338 Achartz, Denise Anderson Denise Denise Achartz 26 Achartz Denise Anderson
6389 Achberger, Karen R Karen Karen Achberger 27 Achberger Karen B
6390 Acheson, Virginia Hyde Virginia Virginia Acheson 25 Acheson Virginia Hyde
6391 Adair, Geraldine Ann Geraldine Geraldine Adair 29 Adair Geraldine Ann
6392 Adair, Jeffery Ellis Jeffery Jeffery Adair 30 Adair Jeffery Ellis.
6393 Adam, Ibrahim Mume & Mounira & Ibrahim and Mounira Torahim and Mounira Adam 31 Adam Ibrahim Mume 32 Adam Mounira A
57l | cona A o In Chricki o L o In fod 33 Ad o L laricki

&
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Steps to Export from the Donors/Voters (Contacts) List

Navigate to the Voters (Donors/Contacts) list under the Application Menu.
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o-l  Settings  Help

Application Menu €

[E]: =

Tazks
fs Dashboard
[» % Committee
» & Calendar/Tasks
[ % Canvassing
F @ Voter
Vaoters “_

Minnesota Voter List
@ Addresses
@ Househaolds
Yoter Relationships
r—U Lawn Signs
By shared Databases
- @ Contributions/Pledges
& (7 Product Sales
[+ fi:} Logs
47 Polling
I+ 55 Communications
> ¢iB Finandial
[ % Disclosure
i g System Manager

Build and run your search query (make sure you load all results if the list is over 1k). In my example | searched for anyone in my database who lived
in the state of Minnesota which produced 66,341 records.
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Build and run your search query.

' <o Search . Reset | db New ok Of B File » Edit - | ) | S Include Other | Voters
Q

Favories | General | #* Address | Household | Vote History | Attiibute | Canvass | Poll | Relstion | Lawn Sign | Contribute | Pledge | Event | Sales | Log | Admin | saL |

@ Address Types Address|M&m' dl Jistrict IUser |Types|
Default Display = Nation: - o
Mailing = o ’
[¥] Main Home LN Address:
[T] Main Wwork
[] Other Home
Other Work
Registration City: -
Current Addresses State: MN
Zip Code: i

Results

8 Edit £ Sort B Format ~ 53 Wrap DE Export & Print
Voters [ 66341 records found ]

@ Summary D] B

ID ~ Last Name ;‘;ﬁ . M1 ?:p‘i’“‘ Strest Street2  City State Ei:d . EB:-iarE: g::‘ County €D SD LD  Regld
2 Aaberg Jlamon lerome 3915 Noble Ave N Robbinsdale W 55422 144971 ,M— Hennepin ,—,TIF 1473

3 Aaberg Kathring Mary @'J 3915 Noble Ave N Robbinsdale MM 55422 1/1/1965 Hennepin 05 456 | 1473707
4 Aaberg Marjory Florence @ |soasthste Starbuck MW | 56381 111961 | F Pope 07 |13 [13A |1512013
H Aaker Kalynn Kay @J 20644 Justice Path Lakeville MM 55044-5974 111977 | F Dakota 02 |58 58A | 3940986
[ Aalders Micki loy @'J 4756 Georgia Ave N Crystal MM 554254629 1/1/1963 | F Hennepin 05 45 454 | 1544345
1 Aalegaard Wendy lo @ 3040 Sumter Ave N Apt102 | Crystal MM 55427-2757 141977 | F Hennepin 05 |45 45B | 3593365
8 Aalgaard Heather Allison @'J 65600 32nd Ave N Crystal MM 55427 1141977 |F Hennepin 05 45 456 | 3457082
9 Aalgaard Swanhild Marie @ 2930 Douglas Dr M Apt 215 | Crystal MM 55422 1414925 | F Hennepin 05 45 456 | 1185146
10 Aalgaard Tad Richard @J 6600 32nd Ave N Crystal MM 55427 111972 (M Hennepin 05 |45 456 | 3457031
11 Aalsma Aaron lohn @'J 5500 56th Ave M Apt 25 Mew Hope MM 55428 1/1/1978 | M Hennepin 05 45 454 | 2430043
12 Aalsma Matalie Sara @J 8500 56th Ave M Apt 25 Mew Hope MM 55428 1/1/1976 | F Hennepin 05 |45 45A | 3793975
13 Aamodt lohn Emil @'J 6908 35th Ave N Crystal MM 55427 1/1/1928 | M Hennepin 05 |45 456 | 958279

14 Aamodt Scott leffery @ | 7011 59th ave N Crystal MM | 55428 111971 | M Hennepin |05 |45 |45A |3327162
15 Aamold Kimberly Ann @ 3011 Boone Ave N Mew Hope MM 55427-2413 111975 |F Hennepin 05 45 458 | 1562564
16 Choukalas lennifer loy @ 3813 Unity Ave N Robbinsdale MM 55422 141972 |F Hennepin 05 45 458 | 3573000
i7 Aanerud Jeananne Kim @ 3819 Independence Ave N Mew Hope MM 55427 1/4/1958 | F Hennepin 05 |45 454 | 1139631
18 Aanerud-Vallis Corliss Ann @'J 2715 Hillsboro Ave N Apt104 | MNew Hope MM 55427 1/1/19%6 F Hennepin 05 45 4548 (1167972
19 Aarnes Jaimi Cara @ 4215 Oregon Ave N Apt627 | New Hope MM 55428 144971 |F Hennepin 05 45 454 | 1551235
20 Aaron Shirley Carolyn @ 1430 Newton Ave N Minneapaolis MM 55411 111936 |F Hennepin 05 59 S59B | 1067048
21 Aarsvold Rachel Marie @ 9700 45th Ave M Plymouth MM 55442 144980 | F Hennepin 15 45 454 | 1505215
22 Aase lan Erik @ 17565 Toth Ave N fMaple Grove MM 55311 1/1/1960 Hennepin 03 |34 344 | 1448320



http://www.trailblz.com/kb

& TrailBlazer

Organize.Leverage. Succeed. How to Run a Household Export of Contact (Voter/Donor) Data to a
.CSV Spreadsheet

Click the File drop-down menu and select Utilities > Export. You must have appropriate security clearance.

1

| <3 Search W, Reset |4k New |3|E 0 | ) ¥ (& (2 | File +| Edit ~ | & | 8pInclude Other | Voters |
G icati »
@ | * omm.umca IoRs
Favorites | General | /% Address |+hjsd1dd|WeHﬁw|FﬁMel% Reporting > Jun Sion | Contriute | Pledoe | Fvent | Sales [10a | Admin | SQL |
= G Utilities v |[a Export... wg
' (& Import
mport...
| Address Types Address |Adcﬂiond | Diistrict | User I T}pes| . |_I Export with options i
Default Display | e &) Import Voting
HeeH 1 -
Mailing = I [ S5 Dete
. - =X
Main Home = Address:
Main \work 8d  Merge..
Other Home ) . )
Other Wark =3 Find Paossible Duplicates...
Registration City: S{ Split Couples into Separate Yoters...
Current Addresses State: MN (B8 Sertin Household Walking List Order...
Zip Code: i

=2 Edi oER @ int [ Detai = pi

=8 Edit |@50r‘c @Format =3 Wrap | EExport &Prmt | Sumrmary D:I E |P||.fot |

Voters [ 66341 records found ]

ID =~ LastName et MI ?dede'e“ Street Street2  City State 2P ot SN County

ul_ 2 Aaberg lamon Jerome 3915 Noble Ave N Robbinsdale MHN 55422 1/1/1971 (M Hennepin |
|

Kathrine 3915 Noble Ave N Robbinsdale Hennepin

Marjory Flarence 504 3th St E Starbuck Pope

Ealynn Kay 20844 Justice Path Lakeville - Dakota
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*If you’ve householded your database you should choose the ‘Combine by Household’ option which will use the households you’ve created and

most likely customized.

*If you haven’t householded your database you’ll choose the ‘Combine by Home Address’ option. In this example | selected the Combine by Home
Address option.

Click [OK] after selecting your export preference.
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NOTE: *if you've already householded your database you
should select this option which will use the custom configurations
you've created when householding your database.

¥ .— ..
Export List View / El

Export Options

2

() Combine by Household

Uses the previously defined Household linkage to combine. If no household linkage, creates
SEPARATE records.
Would be used for "Smith Family” type letters. Where the household contains the Salutation.
Unlinked records have no salutation.
John Smith

m. | »

1

() Combine by Last Name and Home Address

Make a single record where last name AND address are the same,
Would be used for “Smith Family” type letters.
Creates a calculated household name from the given list.
| John Smith
Mary and Alex Jones

@ Combine by Home Address

Combines duplicate addresses into single record regardless of last name differences.
Would be used for "Current Resident” type letters, Creates a calculated household
name from the given list.

1 Creates a calculated household name from the given list,
John Smith, Mary and Alex Jones

() Individual

Exports each record,

List Characteristics
In addition to what is selected on the list view, add:
[[] Home Address [7] Mail Address

[] Phone Mumbers [7] E-Mail
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You’ll get a load animation as the utility runs. If you’re exporting hundreds of thousands or millions of records this could take awhile.

Progress

Progress

Combining records...

|
Cancel

Choose the location on your machine to save the file to, create a name (don’t use special characters), and click [OK]. Make sure you leave the file
type as a .CSV. My example is below where | saved it to my desktop.
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1. Choose your location to save the file.

Save As E
— —
m [ Dsk‘tfrp 3 - ‘ +4 ‘ | Search Desktop e |
Organize « Mew folder 4= = @
| 5% Favorites Marme : Size ¥ Item type Date modified
| Bl Desktop - Libraries
L Temp A jkristenson
4 Downloads (8 Computer
"l Recent Places ?! Metwork
1 Accounting File folder 8/12/2016 11:18 AM
| Bl Desktop | Data File folder 10/11/2016 10:27 AM
- Libraries 1 Sales File folder 8/18/2016 10:18 AM
@ Documents 1. Support & Training File folder 10/18/2016 8:55 AM
Jﬁ Music
[E=| Pictures
I B videos I
; A jkristenszon
I L Computer I
| ﬂ“' Metwork
| 5 Control Panel
| ' Recycle Bin
| 1. Accounting
I )i Data
I 1. Sales
L. Support 8 Training .
l 2. Create a name (don't use special characters).
| ‘/
| File name: 2016-10-21-household-export-of-data-all-contacts-in-minnesota-from-trail-blazer -
| Save as type: |csv files (F.csv) b
I
| Yo -
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You’ll get another load animation as the file exports.

Progress

Progress

Creating export file...

Cancel

When the export is finished you’ll get a popup message with the results. Click [OK] to finish. Typically the record count would drop substantially, if
you have a lot of households in your list. In my example the final list was 37,861 records.
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http://www.trailblz.com/kb

& TrailBlazer

Organize.Leverage. Succeed. How to Run a Household Export of Contact (Voter/Donor) Data to a
.CSV Spreadsheet

Voter List exported to file

"Colsershjkristensont Desktoph2016-10-21-household-export-of-data-all-contact
s-in-minnescta-from-trail-blazer.csv” -- 37861 rows written.

After running the household export you'll get a count
of the 'total number of households' exported to the spreadsheet.

Locate the file on your local machine and open it in the program of your choosing (i.e. Excel, or Numbers). In my example it was on the desktop and
| used MS Excel.

KNOWLEDGE BASE www.trailblz.com/kb 12
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@Qv|- Desktop »

Organize + 7 Open

Mew folder

4757 Favorites
Bl Desktop
L Temp
4 Downloads

oz
1= Recent Places

4 Bl Desktop
4| o Libraries
[> @ Documents
3 Ji Music
I* =] Pictures
& B Videos
[ @& jkristenson
&M Computer
[ “! MNetwork
[ @ Control Panel
Recycle Bin

Lg|

. Accounting
, Data

) Sales

A~

. Support & Training

MName Size Item type
= Libraries

A& jkristenson

1M Computer

“! Metwork

@ Control Panel

= Recycle Bin

. Accounting File folder
./ Data File folder
. Sales File folder
. Suppert & Training File folder
[EL] 2016-10-21-household-export-of-data-all-contacts-in-minnesota-from-trail-blazer.csv 14 449 KB Microsoft Excel Comma Separated Values File

Locate and open the file.

Date modified

8/12/2016 11:18 AM
10/11/2016 10:27 AM
8/18/2016 10:18 AM
10/18/2016 8:55 AM
10/21/2016 4:17 PM

The spreadsheet will contain a lot of information by default, notably the Household columns which can be used on envelopes/labels if you're
running a mail-merge campaign. My example is below.

KNOWLEDGE BASE www.trailblz.com/kb
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Example household export. The houshold columns will get created automatically (even if you haven't householded
your database before).

(X9~
Home Insert Page Layout Formulas Data Review View Developer Team
& cut Calibri =E= %] B S Wrap Text General - ﬂ ﬁ Bad Good Neutral E- §( ’E\ Z A
) acom - = - ok
faste F Format Painter I u- = e merge s Ceger - § ¢ % v 5D 50 FCOOrI;Indaﬂ;ﬂgﬂlv a:&;;fglﬂ:v m Explanatory ... |Input Linked Ce Note Insert Delete Format a4
Clipboard ] Font ] Alignment [F] Number ] Styles Cells
Al v Jfr | HousehaldedFirstNames i
[ A B C E F G H 1 ]
1 |Househo|dedFir5tName5 HouseholdedNickNames HouseholdedFullNames Inclufe  Voterld LastName FirstName MiddleName Suffix BirthDate
2 Jamon, Kathrine & Krystal Jamon, Kathrine & Krystal Jamon & Kathrine Aaberg, Krystal Hulegaard TRUE 2 Aaberg Jamon Jerome 1/1/1971 0:00
3 Marjory Marjory Marjory Asberg TRUE 4 Aaberg Marjory Florence 1/1/1961 0:00
4 Wendy & Beverly Wendy & Beverly Wendy Aalegaard, Beverly Ratican TRUE 7 Aalegaard Wendy Jo 1/1/1977 0:00
5 Swanhild Swanhild Swanhild Aalgaard TRUE 9 Aalgaard Swanhild Marie 1/1/1925 0:00
6 Tad & Heather Tadsssss & Heather Tad & Heather Aalgaard TRUE 10 Aalgaard Tad Richard 1/1/1972 0:00
7 Aaron & Natalie Ace & Natalie Aaron & Natalie Aalsma TRUE 11 Aalsma Aaron John 1/1/1978 0:00
2 John John John Aamodt TRUE 13 Aamodt John Emil 1/1/1928 0:00
9 Scott, Tim, Janice, Kathryn & Ezra Scott, Tim, Janice, Kathryn & Ezra Scott Aamodt, Tim Boone, Janice Grice, Kathryn Kraning, Ezra Watson TRUE 14 Aamodt Scott Jeffery 1/1/1971 0:00
10 Jeananne & Emily Jeananne & Emily Jeananne & Emily Aanerud TRUE 17 Aanerud Jeananne Kim 1/1/1958 0:00
11 Corliss Corliss Corliss Aanerud-Vallis TRUE 18 Aanerud-Vallis Corliss Ann 1/1/1966 0:00
12 Jaimi Jaimi Jaimi Aarnes TRUE 19 Aarnes Jaimi Cara 1/1/1971 0:00
13 shirley & Linda Shirley & Linda Shirley Aaron, Linda Eaglespeaker TRUE 20 Aaron Shirley Carolyn 1/1/1936 0:00
14 Jan & Laci Jan & Laci Jan & Laci Aase TRUE 22 Aase Jan Erik 1/1/1960 0:00
15 Merle & Sandra Merle & Sandra Merle & Sandra Aase TRUE 24 Aase Merle 1 1/1/1933 0:00
16 Theresa Theresa Theresa Aaseby TRUE 26 Aaseby Theresa Ann 1/1/1979 0:00
17 Jaime & Michael Jaime & Michael Jaime & Michael Aasen TRUE 27 Aasen Jaime Lyn 1/1/1976 0:00
18 Jeanette Jeanette Jeanette Aaserud TRUE 29 Aaserud Jeanette Arlene 1/1/1932 0:00
19 Susan Susan Susan Abalan TRUE 30 Abalan Susan Lee 1/1/1943 0:00
20 William & Betty William & Betty William & Betty Abatte TRUE 32 Abatte William Matthew 1/1/1941 0:00
21 Dean & Stephanie Dean & Stephanie Dean & Stephanie Abbott TRUE 34 Abbott Dean Scott 1/1/1964 0:00
22 Tommy & Linda Tommy & Linda Tommy & Linda Abbott TRUE 37 Abbott Tommy R 1/1/1943 0:00
23 Cathy Cathy Cathy Abboud TRUE 38 Abboud Cathy Joy 1/1/1957 0:00
24 Jody & Saado Jody & Saado Jody & Saado Abboud TRUE 39 Abboud Jody Elizabeth Osman 1/1/1959 0:00
25 Abdousalam, Zayatona & Rahina Abdousalam, Zayatona & Rahina Abdousalam Abdoullahi, Zayatona Ahmed, Rahina Mohamed TRUE 41 Abdoullahi Abdousalam amei 1/1/1959 0:00
26 Halim & Nancy Halim & Nancy Halim Abdul-khabir, Nancy Berggren TRUE 42 Abdul-khabir  Halim 1/1/1968 0:00
27 Fathya & Steven Fathya & Steven Fathya Abdulla, Steven Kohler TRUE 43 Abdulla Fathya 1/1/1960 0:00
28 lkram Ikram Ikram Ibrahim TRUE 44 1brahim lkram Ahmed 1/1/1973 0:00
29 Amir Amir Amir Abdus-Salam TRUE 45 Abdus-Salam Amir Solaimon 1/1/1969 0:00
30 Yetmwork, Vatican & Zewdu Yetmwork, Vatican & Zewdu Yetmwork & Vatican & Zewdu Abebe TRUE 46 Abebe Yetmwork H 1/1/1959 0:00
31 Maryanne, Margaret & Elizabeth Maryanne, Margaret & Elizabeth Maryanne & Margaret Abeid, Elizabeth Olson TRUE 48 Abeid Maryanne Michele 1/1/1969 0:00
32 Benjamin Benjamin Benjamin Abel TRUE 49 Abel Benjamin Raymond 1/1/1982 0:00
33 Christopher, Christina, Leonard & Mary Christopher, Christina, Leonard & Mary  Christopher & Christina & Leonard & Mary Abel TRUE 51 Abel Christopher John 1/1/1974 0:00
34 Gordon Gordon Gordon Abel TRUE 53 Abel Gordon Kent 1/1/1949 0:00
35 Leonard & Dawn Leonard & Dawn Leonard & Dawn Abel TRUE 55 Abel Leonard Joseph Ir 1/1/1972 0:00
36 Matt, Amanda, Trevor & Andrew Matt, Amanda, Trevor & Andrew Matt & Amanda Abel, Trevor Hoff, Andrew Paulson TRUE 56 Abel Matt william 1/1/1978 0:00
37 Tina & Getu Tina & Getu Tina Abel, Getu Belayneh TRUE 58 Abel Tina Lynn 1/1/1982 0:00
38 Harris & Marie Harris & Marie Harris & Marie Abele TRUE 59 Abele Harris D 1/1/1941 0:00
39 Mikel Mikel Mikel Abele TRPE 61 Abele Mikel 1/1/1974 0:00
40 James James James Abell TRUE 63 Abell James G 1/1/1948 0:00
H 4 » M| 3016-10-21-household-export-of- %1 []4] 1l |
| T =
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It’s not a bad idea to remove columns you don’t need, adjust the formatting of the spreadsheet, and save the file as an .xIsx so that it retains
formatting.

Steps to Export from ‘Households’ List

In order to export from Households you’ll first need to household your database. Once that’s complete, navigate to the Households list, and run
your search query. In this example | populated all household records which provided 2,396 records.
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2. Build and run your search que

Q Settings  Help

Application Menu «d | <39 Search e Reset | <4k New o s File - Edit + | ) | Household List
B =@ —

[lasks [ Favorites | Name | Count | Denor (Any) | Denor (1) | Denor @ [ SaL |

[ Dashboard

[ % Organization 0 |

» § Calendar/Tasks
B @ Canwvassing
Fl % Donor

[EE Donars Envelope Name:
@ Addresses 1 Manually Adjusted (vs. untouched after creation by Trail Blazer)

@ Households ‘-—

[EE Donor Relationships
|» ‘@ Contributions/Pledges
b % Product Sales

@ Name:

Salutation Name:

3. Click on [Format] to begin adding/removing the columns you want.

[ @ Logs
| 2 Communications
I+ ¢ Financial
B % System Manager
HH Houserjold . Zip #
o + Household Name Salutation Household Envelope Name Street Street2 Streets  City State Code Household
Mame Members
. Lane, Heather & Stuart Heather & Stuart Heather & Stuart Lane 3525 Brunswick Ave N Crystal 55422 2
4933 Roe, Ben & Alex Ben & Alex Ben & Alex Roe 4530 Foxberry Dr Medina MM 55340 2
4332 Bassett. Scott & Patricia Scott & Patricia Scott & Patricia Bassett 12410 29th Ave M Plymouth MM 55441 2
4931 Wrase, David & Mae David & Mae David & Mae Wrase 1715 Garland Ln M Plymouth MM 55447 2
4930 Carter. Mike & Jill Mike & Jill Mike & Jill Carter 1750 Ranier Ln M Flymouth MM 55447 2
McGrane, Patricia J. & Briana Patricia & Briana Fatricia McGrane & Briana Mcgrane 2330 Yuma Ln M Flymouth MM 55447 2
Kelly, Eugene & Monica Eugene & Monica Eugene & Maonica Kelly 1410 Pineview Ln N Flymouth MM 55441 2
Jensen, James & James James Jensen 1845 Garland Ln M Flymouth MM 55447 2
Wilkes, Tristan & Pamela B Tristan & Pamela Tristan & Pamela Wilkes 11715 S50th PI N Plymouth MM 55442 2
Stetler. Jack & Christine Jack & Christine Jack & Christine Stetler 3740 Yellowstone Ln M Minneapolis MM 55445 2
Young, Bill & Bonnie Eill & Bonnie Eill & Bonnie Young 1845 Holly Ln N Plymaouth MM 55447 2
Sperry, Chris & Anita Chris & Anita Chris & Anita Sperry 17735 45th PIN Plymaouth MM 55446 2
Piering. Kate & Angela Kate & Angela Kate & Angela Piering 17425 Bth Ave M Plymouth MM 55447 2
Schmitt, Danielle & Zach Danielle & Zach Danielle Schmitt & Zach Schmtit 1315 Bavarian Shores Dr Chaska MM 55318 2
Vanyo, Michael & Lori Michael & Lori Michael & Lori Vanyo 1135 Pine View Dr Orono MM 55356 2
Baker. Andrea & Cassie Andrea & Cassie Andrea & Cassie Baker 3031 Boone Ave N Mew Hope MM 55427 2
Cooke, James & Dede James & Dede James & Dede Cooke 2909 Bay 5t Wayzata MM 55391 2
Zook, Lynn & Liana N Lynn & Liana N Lynn & Liana N Zook 16415 39th Ave N Plymouth MM 55445 2
Gardner, John & Lynne John & Lynne John & Lynne Gardner 320 Brockton Ln Plymouth MM 55447 2
Stern. Robert & Andrew Robert & Andrew Robert & Andrew Stern 4700 Yuma Ln N Plymouth MM 55445 2
Leonard. Charles & Julie Charles & Julie Charles & Julie Leonard 5§20 Ranchview Ln Plymouth MM 55447 2
Carpenter, Casey & Mary Casey & Mary Casey & Mary Carpenter 6417 Ranchview Ln N Maple Grove MM 55311 2
Olsen, Kris & Dara Kris & Dara Kris & Dara Olsen 3205 Quinwood Ln M Flymouth MM 55441 2
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To add/remove columns of information that you want you'll click on the [Format] drop-down and select columns. For more information on
formatting read this article, and watch this video. For info on formatting with joined tables, watch this video.

=8 Edit | B Sort —#rint | ) Pivot
For Mailing Export

Columns... I Househaold
Salutation Household Envelope Mame
Mame

Select saved...

Sa[ Add or remove columns, apply formatting, or specify column attributes. |

Cayve Az Heather & 5tuart Heather & 5tuart Lane
Ben & Alex Ben & Alex Roe

Scott & Patricia Scott & Patricia Bassett
Wrase, David & Mae David & Mae David & Mae Wrase
Carter, Mike & Jill Mike & Jill Mike & Jill Carter

Assign as default..,

Hﬁﬂﬂﬂ“

<]

MciGrane, Patricia ). & Briana Patricia & Briana Patricia McGrane & BEriana Mcgrane

The default table that’s selected will be households. This has information tied to the household record but not each member of the household.
Example below.
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3) Column Selection - E‘Eﬂ
Columns | Fommat

Table Columns [Household]
E Househaold = AdjustedBylser
=1 AuditCount (i
AuditFirstDate .
AuditlastDate p
ContributionCount
ContributionCountCurrentCycle =
ContributionCountForeign

CaontributionDateRa
The default table = ConbuterDaeforge

' H ContributionLastDate
that's selected will ContbutonLast
- ContributionTotal CurrentCycle
Prov.de data — CDrltributi{:nTDtaIF{:reign
ContributionTotalNextCycle
attached to the ContributionTotalPriorCycle
EnvelopeName
'Household' table. HouseholdID
HouseholdName
Include
ManCaontributionDateRangs
NenManContributionDateRange
PrimaryDonorld
SalutationMame
SecondaryDonorld
UseCount
UserVirtuzlBocl
UserVirtuzlBool2
UserVirtuslBoold
Joined Tables UserVirtuzlBoold L4
UserVirtuzlDateTime
‘Q 4 [ Household = UserVirtualDateTime2
4 [ Doner 1 UserVirtualDateTime3
B} AddressDefault Display UserVirtuzlDateTimed
fE) AddressHome UserVirtuzlDecimal
() AddressMailing UserVirtuslDecimal2

) AddressRegistration UserVirtuzlDecimal 3

User\irtualDecimald
FER) AddressWork v UserVirtualInteger -

»
-
)

m

Progress
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In order to pull in information related to the household members you’ll need to select the joined tables in the bottom-left of the screen and then
the relevant columns on the right. For example if you want their address information it would be under joined ‘Address’ tables. Example below.
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2) Column Selection - E‘éu
Columns | Farmat

Table Columns [Donor 1]
Household =& AddressCount -

—T
= AddressCountCurrent
AddressDefaultDisplaylD

AddressEffectiveDate

i Y ¢ W

AddressFlagCount/DefaultDisplay
AddressFlagCount'Former
AddressFlagCount/MainHome
AddressFlagCount/Main\ork
- -
cking on the different AdressFlagCountOtherHome
. . AddressFlagCount/Otheriviork
joined tables will provide = AsressFissCoumRegistaton
AddressMailinglD
' AddressMainHomelD
- AddressRegistration|D
different members of the séHocDateTime?
. AffidavitMumber
household (i.e. age, gender, 7 -
. . AlEmzilAddress
cantribution data, address, = AtnsiwiingOpinCorfornaion
[ miai | Bown
AltEmailEnabled
a d contaCt data)' AltEmaillmported&waitingO ptinConfirmation
I AtEmailimportedDoMotMail
AltEmailMessagesOpened
* AltEmailMessagesSent
Joined Tables AltEmazilNote
) AppointmentCount
) AddressDefaultDisplay | AttendingEvent
@ AddressHome AuditCount
@ AddressRegistration 1 Auditl astDate
) AddressWork BirthPlace

AddressFlagCount'Mailing
AltEmailListFlag
‘Q 4 [ Donor 1 i AltEmailUnsubscribed
BEF) AddressMaiing AuditFirstDate
4 ) Donor 2 8 Birth Yer }

Progress
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Here’s an example of adding in address information.
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3) Column Selection

Formatting in address information for households using

Columns | Format

Table

% Household

les

4 @ Household
4 @ Donor 1
) AddressDefault Display
@ AddressHome
@ AddrezsMailing
) AddressRegist
) AddressWaork

Columns [AddressMailing]

=g DatelurisdictionDataRefreshed
e DSF

FIPS

Hospital
ImportReferencekey
ImportReferencekey2
Include

IsStreetOdd
Judicial&ppealsCourtDistrict
Judicial DistrictCourtDistrict
JudicialJusticeofPeaceDistrict
Judicial SupremeCourtDistrict
Latitude

LD

Longitude

LOO

LOT

MailCarrierRoute
MailDeliveryPoint

Mcd Code

Mcd Name
MultiUnitBuildingfddress
NaticnCode

Park

Precinct Code

Precinct Name

Precinctld
PublicServiceComm

School

School Sub / Board

S0

Soil Water

State

State Board / BESE

Street

Streetd
StreetCityStateZipBlack
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Once you're finished going through the joined tables, click [OK] to add/remove the columns into the grid.
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) Column Selection - Eni

Columns | Farmat

Table

% Household

1
L

Joined Tables
H @ AddressHome -
@ AddressMailing
@ AddressRegistration
) AddressWark
4 E{ Donor 2
@ AddressHome

Columns [Donor 2]

s |
[T g
[T g

ContributionCount
ContributionCountAll
ContributionCountBundlerall
CaontributionCountCurrentCycle
ContributionCountDateRange
ContributionCountForeign
ContributionCountFriendAll
ContributionCountNextCycle
ContributionCountPreviousCycle
ContributionCountUser(1
ContributionCountUser(2

ey butionCount'VoterDerivationCustom01
butionCount'/oterDerivationCustom02
butionCountVoterDenvationCustom(3
butionFirstAmaount
butionFirstdmountlUser0l
butionFirstdmountlJserl2
butionFirstDate
butionFirstDate\withinDateRange
butionLastAmount
butionLastAmountForeign
butionLastAmountUserl1
butionLastAmountUser(2
butionLastDate
butionLastDiateForeign
butionMax
butionMaxForeign
butionMaxUserl1
butionMaxUserl2
butionMin
butionMinUser(
butionMinUser(2
ibutionTotal

butionTotal &dHoc 1

butionTaotal 4ppliedToPledges

butionTotal BeforePericd

butionTaotal CurrentCycle

butionTotal DateRange

4

»
[}

I_
+

i TN 4

Progress
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My finished example is below. The columns will be added to the far right of the grid. You can drag them left or right to rearrange them.
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The new columns will be added to the right of the grid.

S3Wrap | 9% Export & Print | R Pivot

—

Houser_wld Household Envelope Straet State Zip :ousehold Birth Age Contribution  Contribution  Contribution  Contribution  Contributio  Contribut
Salutation Mame Mame Code Members Date Last Amount  Max Total Last Date Max Total
(Ann Judy Judy Dimich B 39685 Thorpe Ave W ” Deer River W 56636 1 ” 00 00 00 8/19/2016 36.00 104.00
ar & Stuart Heather & Stuart Heather & Stuart Lane 3525 Brunswick Ave N Crystal MM 55422 2 00 L] L] L] L]
Alex Ben & Alex EBen & Alex Roe 4590 Foxberry Dr Medina MM 55340 2 32.00 32.00 32.00 00 00
Lt & Patricia Scott & Patricia Scott & Patricia Bassett 12410 29th Ave N Flymouth MM 55441 2 00 00 00 8/20/2016 45.00 45.00
d & Mae David & Mae David & Mae Wrase 1715 Garland Ln M Plymouth MM 55447 2 22,00 22100 22100 00 00
& Jill Mike & Jill Mike & Jill Carter 1750 Ranier Ln M Plymouth MM 55447 2 00 00 00 8/20/2016 76.00 76.00
tricia J. & Briana | Patricia & Briana Patricia McGrane & Briall. | 2330 Yuma Ln N Plymouth MM 55447 2 22,00 22.00 22.00 8/20/2016 43.00 107.00
e & Monica Eugene & Monica Eugene & Monica Kelly 1410 Pineview Ln M Plymouth MM 55441 2 54.00 54.00 54.00 00 00
m James James Jensen 1845 Garland Ln M Flymouth MR 55447 2 00 00 00 8/11/2016 32.00 32.00
Ign & Pamela B Tristan & Pamela Tristan & Pamela Wilkesl| | 11715 50th PI N Plymouth (5 () 554432 2 .00 00 00 7/30/2016 11.00 11.00
I& Christine Jack & Christine Jack & Christine Stetler 3740 Yellowstone Ln M Minneapolis | MN 55446 2 43,00 43,00 43,00 ili] ili]
& Bonnie Bill & Bonnie Bill & Bonnie Young 1545 Holly Ln N Flymouth MM 55447 2 54.00 54.00 54.00 6/16/2016 54.00 54.00
& Anita Chris & Anita Chris & Anita Sperry 17735 45th PI N Flymouth MM 55448 2 65.00 65.00 65.00 T/28/2016 193.00 193.00
& Angela Kate & Angela Kate & Angela Piering 17425 8th Ave N Plymouth MM 55447 2 36.00 36.00 36.00 /18,2016 11.00 11.00
Nielle & Zach Danielle & Zach Danielle Schmitt & Zac.. ) | 1315 Bavarian Shores Dr ||| Chaska MM 55318 2 13,00 18.00 18.00 7/29/2016 18.00 18.00
Iael & Lori Michael & Lori Michael & Lori Vanyo 1135 Pine View Dr Crono MM 55356 2 62,00 82,00 82,00 L] L]
ba & Cassie Andrea & Cassie Andrea & Cassie Baker 3031 Boone Ave N MNew Hope RN 55427 2 11/23/2002 |14 00 00 00 7/24/2016 54.00 105.00
5 & Dede James & Dede James & Dede Cooke 2909 Bay St Wayzata MR 55391 2 00 00 00 7/15/2016 §5.00 85.00
ﬁ Liana M Lynn & Liana M Lynn & Liana M Zook 16415 39th Ave N Plymouth MM 55448 2 16.00 16.00 16.00 00 00
Ijn & Llynne John & Lynne John & Lynne Gardner 320 Brockton Ln Plymouth MM 55447 2 00 00 00 6/18/2016 22.00 22.00
t & Andrew Robert & Andrew Robert & Andrew Stern )| | 4700 Yuma Ln N Plymouth MM 55446 2 22,00 33.00 55.00 ili] ili]
|ar|es & Julie Charles & Julie Charles & Julie Leonardl | 820 Ranchview Ln Flymouth MM 55447 2 00 00 00 00 00
lasg[ & Mary Casey & Mary Casey & Mary Carpentely | 6417 Ranchview Ln N Maple Grove | MM 55311 2 00 00 00 &6/158/2016 11.00 11.00
lmﬂ Kris & Dara Kris & Dara Olsen 3205 Quinwood Ln N Plymouth MM 55441 2 64,00 84.00 5400 8/20/2016 22.00 22,00
d & Kasia David & Kasia David & Kasia Luiken 10120 36th PI Plymouth MM 55441 2 00 00 00 6/17/2016 75.00 102.00
B loonif T 2 boonif T 2 lonnifar § S0 ek Aaen € s e | nan coain | =1 nn =180 zann an an
29 1,653.00 2,089.00 3,119.00 11,272.00 | 15,751.00
If you want you can now save the format, and assign it as a default from the [Format] drop-down menu.
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You can now save the new format and assign it
as your default if you need.

SEEdit | Sort [ Format ~ |53 Wrap | &% Export (2 Print | ) Pivot
oo e

Columns... h  Contributiol Contribution  Contribution B

State z
Celect saved... e Max Last Date Total Da

Save EL 8/19/2016 104.00
00 .00

Save As...

Assign as default z —
Save the current format under a specified name

00

8/20/2016
&/20/2016

8/11/2016

The related resources below provide links to a wide variety of similar articles and videos on this topic.
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909

g

Trail Blazer

- YouTube Channel
- Knowledge Base Articles
- 3rd Party Resources

Related Resources

Article: Additional Service — NCOA Append

KNOWLEDGE BASE www.trailblz.com/kb 28



http://www.trailblz.com/kb
http://trailblz.com/Company/AdditionalServices.aspx

& TrailBlazer

Organioe Laverage Succesd How to Run a Household Export of Contact (Voter/Donor) Data to a
.CSV Spreadsheet

Article: Managing Households — Creating, Deleting and Re-Creating

Article: How to Print Household Labels

Article: Creating your Own Custom Relationship Types —2016 Upgrade

Article: Splitting ‘Couples’ into Separate Records En Masse using the Built-In Utility

Article: How to Split a Single Contact Record into a Duplicate Contact Record for Householding a Couple

Article: How to Create a Year-End Tax Letter Addressed to Individuals or the Entire Household using Merge Fields — Nonprofit Only
Article: How to Set an Attribute for All Members of a Household En Masse

Article: Exporting Data (Spreadsheets) to your Mac, from the Remote Desktop App — Mapping Drives

Article: How to Configure your RDP (Remote Desktop) Settings on a PC to Allow Access to your Clipboard, and Disk Drives

Article: Creating and Saving Default Formats for Reporting with the Grid

Video: Households — Delete and Recreate
Video: Households — Combine More Than 5 Members

Video: Households — Drag n Drop

Video: Households — What To Do B4 Householding!!
Video: Reporting 102 — Quick Reports and Exports
Video: Reporting 104 — Joined Tables

Trail Blazer Live Support

© Phone: 1-866-909-8700
® Email: support@trailblz.com
[ §| Facebook: https://www.facebook.com/pages/Trail-Blazer-Software/64872951180
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B Twitter: https://twitter.com/trailblazersoft

* As a policy we require that you have taken our intro training class before calling or emailing our live support team.
Click here to view our calendar for upcoming classes and events. Feel free to sign up other members on your team for the same training.

* After registering you’ll receive a confirmation email with the instructions for how to log into the GoToMeeting session where we host our live

interactive trainings.

* This service is included in your contract.

KNOWLEDGE BASE www.trailblz.com/kb 30



http://www.trailblz.com/kb
https://twitter.com/trailblazersoft
http://trailblz.com/Support/Learning/Events.aspx
http://www.joingotomeeting.com/

